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Abstract

The subject of this thesis was to investigate the possibility of a supplemental
control algorithm to suppress gear alternation in the ZF ECCOM gearbox se-
ries. The acquired solutions were implemented on a dSpace MicroAutoBox II
and connected to a Claas Xerion 5000 to evaluate their effect. The different
approaches have gone through three steps of validation, first a Simulink model
simulation, secondly a tractor simulator test, and finally tests on the real tractor.
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Chapter 1

Introduction

1.1 The company

This thesis work was performed at the company ZF Friedrichshafen AG. With
more than 70.000 employees worldwide ZF is one of the largest manufacturers of
parts for the automotive industry. Their product line consists of transmissions,
steering systems, axle components and much more.

1.2 Problem description

In this thesis a problem that occurs in some powertrain strategies was inves-
tigated. A simplified control strategy1 for the ZF ECCOM2 gearbox series

Figure 1.1: ZF ECCOM 4.5 CVT [7]

was used and it could be forced into
this problem. The gearbox used dur-
ing the tests was the ECCOM 4.5 con-
tinuously variable transmission. This
gearbox is a part of the tractor Claas
Xerion 5000 that is used in agricul-
tural work with the possibility to at-
tach various implements. The EC-
COM 4.5 can be seen in Figure 1.1
and the Xerion 5000 can be seen in
Figure 1.2. During certain situations
when an unexperienced driver choses
to drive with a badly chosen droop
limit3 the gearbox may start alternat-

1Control strategy is the by manufacturer implemented program controlling the powertrain
in the vehicle.

2See section 2.3 for more information regarding the ECCOM gearbox.
3This is a rpm limit set by the driver. For further information about droop limit see

Section 2.7

1



2 CHAPTER 1. INTRODUCTION

ing between the second and third gear. This happens while the tractor is exposed
to heavy loads due to the usage of implements such as a plow or a cultivator.
This means that the problem only occurs if the droop limit and the load of the
vehicle are poorly combined while the velocity reference is higher than what
the tractor currently can reach. Under these conditions the gearbox alternates
between the second and third gear until either the load is changed or the droop
limit has been altered. This effect is undesired since it wears out the clutches
of the gearbox and creates noise as well as small jerks.

Figure 1.2: Claas Xerion 5000 [8]

1.3 Goal of the thesis

The goal of the thesis is to find out how a simple modification of the current
strategy could be implemented to prevent gear alternation. If a small modifica-
tion was possible it should be implemented as a supplemental control algorithm
to the existing powertrain strategy and then tested on the real tractor. It is
considered a plus if the solutions is implementable in the TCU4 software. The
reason for this is that it would be able to work with different strategies, i.e.
strategies that are not developed by ZF.

1.3.1 Subtasks

To solve this a few subtasks were defined in order to complete the main goal:

4For further information about the TCU, transmission control unit, see Figure 2.5.
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• Create a working Simulink model of the VDC5 that can be forced into
gear alternation.

• Implement the solution on the MAB, MicroAutoBox II6, tune it in the
tractor simulator as well as for the real tractor.

• Write a simple manual for MAB.

1.4 Limitations

The possible solution may not make any large alterations to the current VDC.
It should neither be noticeable by the driver nor should driving options in the
current strategy be altered. Finally, the solution should be small and efficient
to save on the calculation power needed.

1.5 Outline of thesis

Since this thesis requires a broad spectrum of background knowledge Chapter 2
takes up a large portion of the report. In addition to this, several appendices
have been added for even more insight in the project. This is done so that the
reader may get involved and have adequate background knowledge to be able to
follow the line of thought behind the solutions. The different parts of the thesis
are divided into the following chapters:

• System description contains the necessary background information to un-
derstand the system investigated in this thesis.

• Analysis investigates the characteristics of the system.

• Method description explains the problem setup as well as the line of work.

• Implementation shows the implementations made in Simulink.

• Simulink model tuning goes through the tuning made to the Simulink
model.

• Result and observations present the results of Simulink runs, tractor sim-
ulations as well as tractor runs.

• Conclusion summarizes the outcome of the thesis.

• Appendix is composed of the guide how to setup and use MAB, large
figures of the Simulink models, the unaltered logbook from the test drives
on the Xerion 5000 and a CAN message table used in the connection setup
between the VDC and the MAB.

5For further information about the VDC, vehicle control unit, see Figure 2.5
6Further information regarding the MAB can be seen in Section 4.1.2.
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1.5.1 Notes to the reader

• The reader should notice that the testing of a solution consists of three
steps:

1. Tests and development of the Simulink model.

2. Implementation on the MicroAutoBox II and then tests on the tractor
simulator7.

3. Final testing and tuning on the real tractor.

• The reader should also notice that most of the Simulink models that are
included in the report can be seen in large versions in Appendix B.

• Throughout the report the expression gear is used but the reader should
know that in a continuously variable transmission there are no fixed gears,
only ranges. This means that when the expression gear shift/change is
used it refers to a shift between the ranges.

• The gear ratios mentioned in this report are not the traditional gear ratios,
they are instead reciprocal ratios. The traditional gear ratio is defined as
ratio =

neng

nout
while the reciprocal ratio is defined as reciprocal ratio =

1
ratio = nout

neng
. The reason for this is that in computer systems it is not

possible to represent the ratio = ∞, but with reciprocal ratio the ratio
goes towards zero rather than ∞.

1.6 Material

1.6.1 Software

• Mathworks Matlab.

• Matlab licenses for Simulink, Real-Time workshop, and Stateflow.

• dSpace TargetLink.

• Vector CANape.

• Vector CANalyzer.

• A Simulink model representing the engine and gearbox, without the VDC
implemented.

7The tractor simulator is a so called hardware in loop simulator, i.e. a simulator connected
to the real control systems such as the VDC, TCU and ECU
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1.6.2 Hardware
• dSpace MicroAutoBox II, see Figure 4.1.

• Claas Xerion 5000, see Figure 1.2.

• ZF ECCOM 4.5 CVT, see Figure 1.1.

• Access to a tractor simulator, a so called hardware in loop simulator.

1.7 Individual contribution
During the first month the work was divided into two parts. The first part
was setting up the communication and learning the programs used with the
MicroAutoBox II, this was done by Henrik. The second part was creating the
Simulink model of the VDC and acquire the background knowledge of the pro-
cess, this was done by Michael. In general Michael has put more time in the
Simulink simulation while Henrik has put more time with the tractor simulator.
Apart from this no specific division was performed.
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Chapter 2

System description

2.1 Powertrain
The powertrain are the parts of a vehicle that generates power, transfers it
and converts it into motion, see Figure 2.1. The powertrain in a tractor using
components from ZF consist of the following parts [1]:

• An engine which generates the power to move the vehicle.

• A u-joint drive shaft that transfers the power from the engine to the
transmission.

• A transmission that adapts the torque and rpm from the engine to the
current driving situation.

• A differential that diverts the power from the transmission to the wheels.

The engine rpm is proportional to the fuel injection, which is determined by
the position of the driving pedal and the driving strategy. Equation 2.1 shows
the relation between the vehicle velocity and the powertrain variables. From
this equation it can be seen that the system has two degrees of freedom, DOF,
engine speed and gear ratio.

V elocity = neng · iG · idiff · ltire · 3.6 (2.1)

Where:

• neng rpm [min−1] - Engine output rpm.

• iG [nounit] - Current gearbox ratio.

• idiff [nounit] - Fixed differential ratio.

• ltire [m] - Tire circumference.

• 3.6 [factor m
s →

km
h ] - Conversion between meter per second and kilome-

ters per hour.

7
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Figure 2.1: Powertrain for a tractor with a ZF CVT [6]
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2.2 Diesel engine
The engine installed in the Xerion 5000 is a Caterpillar, 6-cylinder, 12.5L, which
has a maximum torque of 2350 Nm at 1400 rpm and a power peak of 385kW at
1800 rpm. The torque peak is the point where the engine delivers the largest
torque and the power peak is the point where the product of the torque and the
speed is the highest. The power peak is also the point where the vehicle can
handle the largest load at the highest possible speed.

2.2.1 Performance
The engine performance during different driving situations is crucial and must
be taken into account when designing solutions effecting the engine rpm. In
Figure 2.2 the torque and power depending on the rpm can be seen.

Figure 2.2: Engine performance [8].

2.2.2 Fuel consumption
When the rpm reference to the engine is being calculated the brake specific fuel
consumption, BSFC, curve is a good tool to work with. From this curve regions
where fuel consumption is unnecessarily high may be identified and avoided.
The BSFC can be seen in Figure 2.3. A quick analysis shows that an engine
under load is better the one that is only working in the midrange. This is why
it is favorable to have a driveline strategy that keeps the rpm low when the
vehicle load is small which lowers the fuel consumption. When the load is larger
the strategy keeps the rpm high to be able to satisfy the driver demands.
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Figure 2.3: Engine efficiency (g/kW*h) [14]

2.3 Transmission
The transmission used in the tractor is a continuously variable transmission,
CVT. This means that the transmission is a stepless gearbox and it can de-
liver gear ratios between the standard fixed gears. There are many different
approaches to construct a CVT, in this gearbox this is done with a shifting
drum containing the fixed gears and a hydrostatic unit that delivers the contin-
uously variable part. This gearbox is a so called powersplit transmission that is
a combination of a mechanical and a hydrostatic transmission. An overview of
the CVT can be seen in Figure 2.5. The CVT also has a PTO, power take-off
unit, which can be used to connect implements to the vehicle. This effects the
output to the wheels since some power from the gearbox is diverted to the PTO
instead. The torque flow of the gearbox is shown in Figure 2.4.

Figure 2.4: The torque flow of the CVT.
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Figure 2.5: ECCOM interior view [1] - The hydrostatic unit is better shown in
Figure 2.9

2.3.1 Shifting drum

The shifting drum contains four clutches and four planetary gear sets, as seen
in Figure 2.6, where the clutches decide which parts of the planetary gear sets
that should transmit power. The planetary gear sets consist of four parts, the
sun gear, the planet gears, the ring gear and the planetary gear carrier. Figure
2.7 shows how these parts are connected.

The ring gear of the first planetary gear set is connected to the input shaft
of the transmission and is thereby driven by the engine. The sun gear of the
same planetary gear set is controlled by the output from the hydrostatic unit.
The planetary gear carrier is used to transmit power from one planetary gear
set to the ring gear of the following planetary gear set. The output from the
forth planetary gear set is connected to the KV/KR-clutch, as can be seen in
Figure 2.5, which is used for forward or reverse drive. The KV/KR-clutches give
the vehicle four gears when driving in both directions thus giving the vehicle
full speed in the reversed direction as well. The output of the KV/KR-clutch is
connected to the differential.

Clutches

The clutches in a ZF CVT make sure that there is no gap in the power transfer,
unlike regular cars where no power is transfered during the gear switch. This
type of gap free transmission is known as a powershift transmission. There is
an overlap of the gear ranges so one range is always transferring the power from
the engine. This is done by engaging and disengaging the clutches at the same
time.
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Figure 2.6: Shifting drum interior view [1]

Figure 2.7: Planetary gear set, sun gear purple, planet gears blue, ring gear
grey and planetary gear carrier cyan.

2.3.2 Hydrostatic unit

The hydrostatic unit allows for a continuously variable gear ratio for the vehicle.
It consists of a fixed and a variable displacement pump which are connected to
each other by a liquid flow in both directions. The variable displacement pump
is driven by the engine and consists of a swash plate and pistons as shown
in Figure 2.8. By changing the angle of the swash plate the output flow and
direction of the pump can be altered, thus creating the continuously variable
part of the transmission. The fixed displacement pump has the same design as
the variable displacement pump except that the swash plate is in a fixed position
and is connected to the shifting drum. It supplies the shifting drum with an
additional rotational power that depends on the flow received from the variable
displacement pump. How the hydrostatic unit is connected to the shifting drum
can be seen in Figure 2.9.

2.4 Advantages of CVTs

In agriculture, heavy machinery and implements are being pulled by the tractor
which therefore has a large need of torque. This makes the CVT a good choice
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Figure 2.8: Hydrostatic unit

Figure 2.9: The hydrostatic unit connected to the shifting drum [1]
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since it has a gear ratio beginning at zero. This means that the agriculture
vehicle can perform heavy work at very low speeds. The CVT will, according
to Equation 2.3, have "infinite"1 torque when the gear ratio goes towards zero.
The benefits have been listed in Table 2.1.

neng · iG = nout (2.2)

τin
iG

= τout =⇒ lim
iG→0

τout =∞ (2.3)

where iG is the transmission reciprocal ratio, TRR.

Feature Benefit
Constant, stepless acceleration from
a complete stop to cruising speed

Eliminates "shift shock" - smoother
ride

Works to keep the vehicle in its opti-
mum power range regardless of how
fast the vehicle is traveling

Improved fuel efficiency

Responds better to changing con-
ditions, such as changes in throttle
and speed

Eliminates gear hunting as a vehi-
cle decelerates, especially going up
a hill

Better control of a gasoline engine’s
speed range

Better control over emissions

The ability to have a reciprocal ratio
equal to zero

Better handling of lower speeds and
the ability to stop in slopes without
a hill holder system.

Table 2.1: Advantages of CVT [12].

2.5 Vehicle control units
In the vehicle there are several control units, which are explained below. These
are used to control the different parts of the powertrain. A flowchart of how
these control units interact with each other, the engine and the gearbox can be
seen in Figure 2.10.

VDC The vehicle drivetrain control unit has access to both the CAN-buses
and sends the reference signals to the ECU and TCU. This unit contains
the driveline strategy which has the information on how the vehicle should
behave in different situations. All the inputs from the driver goes via the
VDC and all the actions performed is decided by the driveline strategy
of the VDC. This means that the driver is not in direct control of the
gear ratio nor the engine speed. Apart from the inputs of the driver the

1Infinite in theory since in reality the tires will start slipping when the torque becomes to
high.
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surrounding inputs, such as various loads and environmental conditions,
are processed by the driveline strategy.

ECU The engine control unit takes the rpm reference signal from the VDC
and controls the engine so that the reference is followed when possible.

TCU The transmission control unit takes a gear ratio reference from the VDC
and controls the gearbox so that the reference is followed. This is done by
controlling the hydrostatic unit and shifting the clutches.

Figure 2.10: Overview of the controlled process where the box named logic
represent different approaches to solve the gear alternation.

2.6 Connection overview
In the vehicle there are two CAN buses; CAN vehicle and CAN local, which are
used for communication between the different control units. To implement the
control strategies of this thesis a MAB was connected to the CAN local bus. In
Figure 2.11 the connections between the different units can be seen.

2.7 Droop limit
The droop limit is a setting that is chosen by the driver and is the only known
mode when gear alternation occurs. It is a limit that the engine speed will not
drop below. If heavy load is applied on the tractor the rpm of the engine will
start to drop. When the rpm reaches the droop limit the gearbox will start
gearing down. This action will give more torque to the vehicle, thus allowing
the vehicle to handle the large load. Preventions against further drop of the
rpm is then acquired. The droop limit is defined as a percentage level of the
maximum rpm. It can be used to prevent the engine to drop below the torque
peak, the power peak or whichever limit favorable by the driver. Figure 2.12
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Figure 2.11: The CAN bus connections between the control units and the MAB
in the tractor. Solid lines show connection used, dashed lines show possible
connections.

describes how the droop limit influences the rpm and gear ratio during load.
It can be seen that without any load the rpm of the engine is quite low which
is done to save fuel. When the tractor lowers a tool into the ground the load
increases whereupon the engine rpm is pushed down towards the droop limit.
As the droop limit is reached the gearbox starts lowering the gear ratio. This
action allows the vehicle to handle the larger load while preventing the engine
from dropping further.
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Figure 2.12: The droop limit effect on the engine rpm and the gear ratio. An
enlarged version of the picture can be seen in Appendix B.
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Chapter 3

Analysis

3.1 Gear alternation
The gear alternation occurs when the droop limit and the vehicle load are poorly
combined. This is since the current driveline strategy always tries to push
the gear ratio as high as possible. When the vehicle is under load it will get
pushed down towards the droop limit. If the highest possible gear ratio that
the vehicle can obtain with that load happens to be at a gear shifting point the
gear alternation may start. The conclusion that the problem has two different
approaches was made. Since the load can not be modified the approaches to
adjust the droop limit and limit the gear ratio were investigated. The methods
investigated to obtain this are described in Section 4. To see if there was any
advantage of the higher or lower gear an efficiency analysis was performed on the
Simulink model of the gearbox. The steps to obtain this data can be studied in
Section 3.2. If the gear alternation would occur due to load variations a solution
would be hard to find. Most of those alternations are probably needed for the
tractor to handle the alternating load. The background information provided
by ZF states that the gear alternation occurs with a frequency of approximately
1 Hz. It is unlikely that the load would alternate with the same frequency if
the gear alternation is not only caused by the alternating load. The load of the
vehicle will not be constant when driving on the field due to variations in the
soil and terrain. This may be the cause of some of the alternations and those
alternations may be hard to suppress. The gear alternation on a tractor driving
in field can be seen in Figure 3.1. The following signals are shown:

• The speed reference to the engine, RSSL. (Red)

• The engine speed also know as the transmission input shaft speed, TISS.
(Green)

• The state of the gearbox (shifting or no shifting), TRS. (Yellow)

• The gear ratio of the gearbox, TRR. The gear shifting point is slightly
different on this gearbox and it occurs at 0.45. (Purple)

19
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Figure 3.1: Gear alternation during field drive.

• The engine load, PLACS. (Orange)

• The current gear. (Cyan)

3.2 Gearbox efficiency
To make a more accurate decision regarding the choice of gear an efficiency table
for the gearbox may be used. From this better choices can be made regarding
staying in one gear or changing to the next. In the gearbox efficiency chart,
which can be seen in Figure 3.2, the efficiency of the four gear ranges with
the influence of the hydrostatic unit is shown. The efficiency of the gearbox is
calculated from Equation 3.5. The deriving of that equation can be followed in
Equations 3.1 to 3.5.

η =
Pout

Pin
(3.1)

where
Pout = τout · nout (3.2)

Pin = τeng · neng (3.3)

If Equations 3.3 and 3.2 are used in Equation 3.1 the following equation is
obtained:

η =
τout · nout
τeng · neng

(3.4)
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Figure 3.2: Efficiency chart of the ECCOM 1.8

iG is defined as the ratio between nout and neng ( nout

neng
). If this is used in

Equation 3.4 the following equation is obtained:

η =
τout · iG
τeng

(3.5)

To obtain the efficiency chart a special load controller was developed. This
controller increases or decreases the load of the vehicle depending on PLACS,
the current engine load percentage. Since the gearbox can handle a very large
span of loads on the vehicle a ordinary controller could not be found. The
controller tries to keep the PLACS between 99.5− 99.7%. If the PLACS goes
below this limit the vehicle load is increased and if the PLACS goes above the
vehicle load is decreased. The Simulink model for the controller can be seen
in Figure 3.3 and the control actions taken in different regions can bee seen in
Table 3.1.

The data for Figure 3.2 was obtained by keeping the rpm fixed, which can
be seen in Figure 3.4. This was done while slowly decreasing the reference to
the gearbox, CTRR. The CTRR, TRR and ITRR can be seen in Figure 3.5.
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PLACS value Load increasement / decreasement
< 99% +0.05%
< 99.2% +0.03%
< 99.3% +0.01%

> 99.5 & < 99.7% No action preformed
> 99.7% −0.01%
> 99.8% −0.03%
> 99.9% −0.05%

Table 3.1: Load control action table, depending on the deviation from the de-
sired PLACS different actions are performed.

Figure 3.3: Simulink model of the load controller

In this figure the switching points between the gears and the change of the
direction of the hydrostatic unit can be seen. In the high region of a fixed gear
range the hydrostatic unit "pushes" to acquire a higher TRR and in the lower
half of the gear range the hydrostatic unit "breaks" to gain a lower TRR.

The small disturbances that can be seen in Figure 3.5 correspond to changes
in the direction of the hydrostatic unit and changes between the fixed gears.
These disturbances have been marked in Figure 3.6.

The reason why it is not possible to get a good read of the efficiency at
the end of the run is because the vehicle load capacity increases exponentially.
The load controller can not handle this to adjust the load in a proper way. In
figure 3.7 the load during the run can be seen. As can be seen the load increases
inversely proportional to TRR, which means that theoretically the tractor can
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Figure 3.4: Rpm during efficiency run

Figure 3.5: CTTR/TRR/ITRR during efficiency run
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Figure 3.6: CTTR/TRR/ITRR during efficiency run showing when the direc-
tion of the hydrostatic unit changes and the gear changes

handle infinite load at TRR = 0. In Figure 3.8 a zoom of the load in the area
where the efficiency actually was plotted is shown.

As can be seen in Figure 3.2 the load controller starts getting problems when
TRR is getting small. This is the reason why Figure 3.2 starts at 0.18 instead
of 0. The reader should notice that Figure 3.2 goes from gear ratio 0 to 2, while
the other figures go from 2 to 0.

3.2.1 Gear efficiency effect - needed rpm

Since different gear ranges have different efficiency a higher engine torque might
be needed to compensate for the torque lost in the gearbox. Example 1 illus-
trates this phenomenon with data from the Xerion 5000 [13] and with a gearbox
that has an efficiency jump of 2% for example.



3.2. GEARBOX EFFICIENCY 25

In the gear range shift between the second and third gear the efficiency difference
is around 2% (at 1500 rpm). If the driver, for example, has set the droop limit
to 1600 rpm the engine gives a torque of 2248 Nm. The loss of 2% is equivalent
to a loss of 46.08 Nm at this droop limit. This denotes that if the less efficient
gear is chosen the rpm of the engine needs to be altered so that the torque
output is 2294.1 Nm instead. To acquire 2294.1 Nm a rpm of 1531 is needed
i.e. a 69 rpm lower value than the original 1600 rpm.

Example 1: An example of the effects of the efficiency differences between two
gears. This example was calculated according to list 1.

The efficiency loss between the gears is calculated with Equation 3.6.

ηloss = E(iH)− E(iL)︸ ︷︷ ︸
E(iG) gives the effi-
ciency at iG

(3.6)

The needed torque due to the less efficient gear is calculated with Equation 3.7.

τneed =

Orignal torque︷ ︸︸ ︷
T (ndlim) +

Extra torque︷ ︸︸ ︷
T (ndlim) · ηloss︸ ︷︷ ︸

T (rpm) gives the torque at rpm

(3.7)

The rpm needed to acquire the higher torque is calculated from Equation 3.8.

nneed = R(τneed)︸ ︷︷ ︸
R(torque) equals the rpm
needed to acquire torque

(3.8)

The size of the needed rpm change is calculated with Equation 3.9.

nchange = abs(ndlim − nneed) (3.9)

Calculation 1: The list describes the step for how to calculate the size of the rpm
change needed to handle the efficiency loss in a gear change. This example could
also be used to calculate the size of the limits that are used in Criteria 1 and 3
described in Section 4.3. The size of the droop limit adjustment could also be
estimated from this equation. For further description regarding functions and
variables used see Page ix.
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Figure 3.7: The load during the run

Figure 3.8: The load during the run



Chapter 4

Method description

4.1 Hardware and software description

4.1.1 Test environments
As previously mentioned the algorithm development consists of three steps
which are further explained below.

Simulink model

A model of the engine with the including gearbox was supplied by ZF. To this
model a simplified version of the VDC as well as the problem scenario were
developed by the authors of this report. This Simulink model was used to
construct and to perform the first test of the possible solutions. The MAB was
not used in this step. The shifting point between the second and third gear
occurs at 0.56 TRR at the gearbox implemented in this model.

Tractor simulator

The tractor simulator consisted of a computer that simulated the vehicle output,
but to this simulator hardware such as the VDC was connected as well. This
was used to check the software before testing on the real tractor. This system
is a so called hardware in the loop simulator. The shifting point between the
second and third gear occurs at 0.56 TRR at the gearbox implemented in this
model.

Claas Xerion 5000

As the final step of validation the software was tested on the real tractor on
a test track. To obtain the problem with gear alternation on the test track a
braking wagon was connected to the tractor to simulate the load. The shifting
point between the second and third gear occurs at 0.37 TRR at the gearbox
installed in this tractor.

27
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4.1.2 MicroAutoBox II

MicroAutoBox II, see Figure 4.1, is a real-time system which is used for con-
trolling Rapid Control Prototyping1 applications, e.g. electric drive control,
powertrain and aerospace applications. In our case, the MAB is connected

Figure 4.1: MicroAutoBox II [2]

to the VDC, the ECU and the TCU
via a CAN-bus and is used to imple-
ment our supplemental control algo-
rithm on the real tractor. The box is
programmed by building a model in
Simulink. The model is then trans-
lated to C-code and downloaded to
the box with the help of the Math-
Works Real-Time Workshop [4] (also
known as Simulink Coder). From there the model can operate automatically,
without any human input. At the same time, the signals and parameters in
the MAB can be accessed in real-time by the user through a CAN or Ethernet
connection.

4.1.3 Data collection

To monitor and debug the program running on the MAB and the signals on the
CAN a CANcaseXL log, see Figure 4.2, is connected to the CAN. The CANca-
seXL log is also connected to a PC via USB. Thereby it is possible to change

Figure 4.2: CANcaseXL [5]

parameters and view signals in the
program running on the MAB as well
as view and create signals on the
CAN, all in real-time. This monitor-
ing is done with two programs, CAN-
alyzer and CANape, where CANa-
lyzer grants the ability to work with
the CAN and CANape the ability to
work with the program running on
the MAB. It is also possible to use an
Ethernet connection between the PC
and the MAB to access the parame-
ters and signals on the box. This op-
tion is advantageous since more data
may be collected since the Ethernet
has a larger capacity. This was also
confirmed by empirical experiments.

1"Rapid Control Prototyping or RCP is a process which lets the engineer quickly test and
iterate their control strategies on a real-time computer with real input/output devices." [3]
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4.1.4 CANalyzer

With CANalyzer, see Figure 4.3, it is possible to read messages that are sent on
the CAN as well as create new messages to send on the CAN. The blue squares
in the main window can be used to alter existing messages or create new ones.
In this case, the IG-box2 has been created to send a message to the CAN, see
Figure 4.4. The message has been given a unique identifier and a signal has been
added to the first byte of the message. In the Trace-window, see Figure 4.5, all
the signals on the CAN are displayed in a time-based list. In this list a message
with identifier 64 is received by CANalyzer at regular intervals and the message
from Figure 4.4 is sent once. Signals can also be read from a file with stored
data from a real application.

Figure 4.3: CANalyzer

4.1.5 CANape

With CANape, see Figure 4.6, it is possible to view signals and change parame-
ters in the program running on the MAB. This is done by creating devices from

2This has no connection to the transmission ratio, iG
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Figure 4.4: CANalyzer IG

Figure 4.5: CANalyzer Trace
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different databases. This can for example be a database of all the messages sent
on a CAN or all signals and parameters in an application like the MAB. These
devices can then be used to add individual signals and parameters to the dis-
play and calibration windows. In the display windows the value of signals and
parameters can be displayed in various ways, for example graphically, digitally
or numerically. In calibration windows parameters can be changed by simply
entering a new value in the corresponding field. Each signal and parameter can
also be recorded so that the measurements are available after the measurement
has ended.

Figure 4.6: CANape
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4.2 Setup

Two computers were used during the thesis. One of them was used to conduct
the simulations of the gearbox and the engine in Simulink. To achieve this a
model with the for us important functions of the VDC were created. Then the
settings to trigger the gear alternation was empirically found. Once the gear
alternation problem was found different solutions to fix it were attempted. If
a solution proved to be functional it was extracted from the file and further
processed on the other computer. This computer was mainly used to connect
to and transfer the program to the MAB. In the beginning a lot of work was
put into installing and learning the required software as well as getting the com-
munication working between the computer, the CAN-bus and the MAB. When
communication had been properly configured the solutions were programmed
to the MAB. After this step was completed the MAB was connected to a trac-
tor simulator. With the computer still connected to the MAB the solutions
were further tested and evaluated. When a satisfying result was achieved the
software was further tested on the real tractor. The first tests were conducted
with a brake trailer connected to the tractor. A brake trailer is a trailer with a
controllable retarder that brakes the wheels of the trailer.

4.3 Possible approaches

Since a solution that interfered as little as possible with the current strategy was
preferred no large controllers for the entire VDC were developed. Instead small
alterations to the existing strategy were implemented and tested. As mentioned
in Section 3.1 the problem with gear alternation occurs when the engine is under
heavy load and is pushed to the droop limit. This problem only occurs if the
load is of the size so that the gear ratio is pushed down to the switching point
between the second and third gear. Since there are no implements forcing the
tractor to run at the first and third gear shifting point the problem does not
occur at these points.

The existing strategy tries to push the gear ratio as high as possible. At
the same time the engine rpm is kept at the droop limit. Therefore alterations
of the reference signals were attempted. No attempts were made to change the
rpm reference to the ECU since it was controlled indirectly by the droop limit.
Instead the approach of changing the droop limit was investigated. Different
criteria were identified to trigger the various solutions so that they will not be
active when gear alternation are not possible. Each solution uses one or more
of the following criteria:

1. A region that the TRR should be within, i.e. a hysteresis from the switch-
ing point where TRR equals 0.56. This makes sure the gear ratio is within
the limits of gear alternation.

2. A limit that the engine load percentage, PLACS, should be above, in our
case 98%. This was chosen since gear alternation is only known to occur
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during full engine load.

3. The rpm should be within 10% of the droop limit. This criterion is used
to detect major load changes.

4. Detection of acceleration/retardation so that no alteration should be made
when passing through the gear shifting point. This criterion was only used
in the Simulink model due to difficulties when implementing it on the real
process.

5. The derivative of the velocity error3. If the error increases or decreases
rapidly no precaution should be taken.

6. The velocity error should be positive if a precaution should be active. In
the case that the reference is changed by the driver no approach should
be active.

4.3.1 Droop limit adjustments

Different approaches to adjust the droop limit were developed. By adjusting
the droop limit the engine gets less or more power which will result in a lower
or higher gear. This action will alter TRR so that it is not at the shifting point.
These approaches are described below and the difference between them can be
seen in Figure 4.7. The size of the droop limit adjustment can be calculated
with the equations in Calculation 1 in Section 3.2.

Figure 4.7: The different adjustments made to the droop limit by the different
approaches.

3The velocity error is the difference between the velocity reference and the actual velocity.
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Fixed adjustment

When Criteria 1 and 2 are active the droop limit is increased or decreased by
X%4. The effect is that the TRR can be placed slightly higher or lower than
the gear shifting point. Since the fixed adjustment will alternate between being
activated and deactivated a PWM, puls width modulation, will occur so the
droop limit will in fact be pushed less than ±X%.

Pole adjustment

Version 1
When Criterion 4 is not active the droop limit is adjusted with the following
function; adjustment = K

abs(TRR−0.56) . The size of the factor K decides how
strong the adjustment will be and the sign of the factor influences if the adjust-
ment should be positive or negative.

Version 2
During the project the conclusion that an active choice has to be made depend-
ing on if the droop limit should be increased of decreased. This conclusion led to
that the absolute function was removed which means that the adjustment is ei-
ther negative or positive depending on if TRR approaches the shifting point from
above or below. Therefore, the adjustment used was adjustment = K

TRR−0.56 .
The impact this adjustment has on the droop limit can be seen in Figure 4.8.
The effects that the pole adjustment has got on the rpm, the droop limit and
the TRR can be seen in Figure 4.9.

Integration adjustment

When Criteria 1 and 2 are active an integration of a constant begins. Depending
on the sign of the derivative of TRR the integral value is increasing or decreasing.
The droop limit is then adjusted with this value. This value will converge
towards the necessary offset to avoid alternation between gears.

Linear adjustment

When Criteria 2 and 4 are active a linear adjustment is applied. This is done
when iG is between 0.56 ± 0.04, with the largest adjustment at 0.56 and no
adjustment at the end points.

Logarithmic adjustment

The logarithmic adjustment works similar to the second version of the pole
adjustment. The difference is that instead of adjusting the droop limit by a pole
in the gear switching point the droop limit is adjusted through the equation
sign(TRR − 0.56) ∗ log(abs(0.56 − TRR)). Unlike the pole adjustment the
log adjustment starts to adjust the droop limit earlier and it is not quite as

4The X could be derived from Calculation 1.
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Figure 4.8: The adjustment made to the droop limit depending on the current
TRR by the pole method.

aggressive close to the switching point. In Figure 4.10 the impact of the log
adjustment can be seen.

4.3.2 Range shift limitation
The RSL approach prevents gear alternation by a lock-down of the gearbox.
This means that gearing is only allowed in one direction, either up or down.
By triggering on all the criteria the RSL is activated and thereby locking the
gearbox. The criterion number 3 is needed in the case that the load increases
during a lock of the gearbox in the third gear. This is done to prevent engine
failure. In Figure 4.11 the effect that RSL has on TRR can be seen. The effects
that the RSL approach has on the rpm and the TRR can be seen in Figure 4.12.

4.3.3 Torque limitation
The torque limitation approach lowers the maximum torque of the engine when
within the critical region5. This forces the gearbox to lower the gear ratio so

5Critical region has the value 1 (true) if gear alternation is possible and 0 (false) otherwise.
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Figure 4.9: The pole adjustment effect on the whole system.

that the vehicle may handle the load when the engine has lowered torque. By
this action the gear ratio will be pushed below the gear shifting point. This
approach is limited to choose the lower gear of the gear switching point since
only lowering of the torque is possible. The effect of the torque limitation can
be seen in Figure 4.13.

4.3.4 Load dependent solutions
If a good estimation of the current load of the vehicle is available a controller
that makes an active choice between the high respectively the low gear could
have been used. Since load estimation currently is unavailable no more work has
been put to this area but in further work these type of load depending solutions
should be taken into consideration.
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Figure 4.10: The adjustment made to the droop limit depending on the current
TRR by the log method.
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Figure 4.11: The effect on TRR for different values of the RSL.
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Figure 4.12: The effect on the system when RSL is set to prevent up shift.
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Figure 4.13: How the torque output of the engine is lowered within the critical
region.



Chapter 5

Implementation

5.1 Simulink model of the VDC

A simplified version of the VDC was created in Simulink. This simplification
could be done since not all of the functions implemented on the VDC were of
interest for this thesis. The main parts created in the VDC were the velocity
controller and the droop limit controller. Besides these regular functions of the
VDC different solutions to solve the gear alternation problem were implemented.
The engine reference controller was only simulated with a constant engine speed
reference. An overview of how the different implemented blocks were connected
can be seen in Figure 2.10.

5.1.1 Simulink block descriptions

Adaptive tuning of the velocity controllers I-part

By looking at the relative error between the velocity reference and the velocity
error a factor is obtained which may be used to continuously change the influence
of the I-part on the controller. By applying this modification a controller with a
fast step response and a smooth control close to the reference value is obtained.
To avoid aggressive control at the gear shifting point a secondary adaptation
scheme depending on the signal critical region is also implemented. The second
adaptation cuts 96-98% of the control signal if the risk for gear alternation is
possible. See Figure 5.1 for an overview of the I-adaption block.

There are two controllers affecting the reference signal to the gearbox. The
first is the main controller which makes sure that the desired speed is acquired,
see Figure 5.2. The second is the droop limit controller that makes sure that the
motor does not drop below a preset rpm, see Figure 5.3. The second controller
makes sure that the gearbox and motor succeed with handling the current load
of the vehicle even though that will result in an error in the desired velocity. The
velocity controller consist of only an I-part in our model. This is implemented
to retrieve a controller that follows well and has not got an offset if switching
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Figure 5.1: The I-adaptive block

between the velocity and droop limit controller. The controller for the droop

Figure 5.2: Velocity controller

limit consist of an I-part, when in normal operation the droop limit controller
is following the velocity controller with a slight positive offset. When the rpm
drops below the preset droop limit the control starts to regulate on the rpm
by lowering the gear ratio instead. To obtain a nice and smooth control signal1
both the integral controllers are reset with the current control signal at the
switching points. The result under heavy load of this implementation will be
an alternation between the two controllers. The gearbox keeps a constant gear
until the droop limit is reached whereupon it starts gearing down. This will
result in the speed being significantly lower than requested but a heavier load
may be handled instead.

5.2 MicroAutoBox II

When implementing the approaches mentioned in Section 4 on the MAB a few
changes were needed. Since the solutions no longer were connected to the rest
of the Simulink model their input and output signals needed to be received and
transmitted via the CAN local bus. In addition to this, signals and parameters
were named to allow for measuring and calibration of the solutions on the MAB,
in real time. To avoid reprogramming the MAB when testing different solutions

1For results of the adaptive controlling see Section 6.
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Figure 5.3: Droop limit controller

all solutions were added to the same Simulink model. Switches were therefore
added for easy switching between the solutions and to assure that not more than
one solution is active at any given time. Explanations of the different parts of
this model can be seen below. For more information on how to set up the MAB
and download a Simulink model to it, see Appendix A. This guide provides the
knowledge needed to use the MAB in the same way as it was used in this thesis.

5.2.1 Communication

In this section the blocks used for setting up the CAN communication and the
XCP, Universal Measurement and Calibration Protocol, as well as receiving
and transmitting CAN messages are explained. These blocks can be seen in
Figure 5.4. To receive and transmit messages on the CAN two types of blocks
were used, the CAN controller setup block and the receive/transmit blocks. The
CAN controller setup block establishes the necessary settings for communica-
tion over CAN. The receive blocks (light green) were used to receive messages
from the CAN and the transmit blocks (light red) were used to send a message
to the CAN. One block corresponds to one CAN message. The outputs from
and inputs to these blocks are the used signals of the messages the blocks cor-
responds to. The gains and biases are used to scale and offset the signals. For
information about the CAN messages, identifiers, signal start bits, lengths etc
see Appendix D. A multiport switch was used to switch between the different
solutions for adjusting the droop limit. The onoff parameter decides which of
these solutions that is active and the onoff input to the CAN transmitter tells
the VDC if any droop limit adjustment is active or not. The red box named
Constant1 was used to send a constant value to adjust the droop limit. To gain
access to the signals and parameters in the Simulink model XCP on Ethernet
were used. This means that, with the help of the protocol, a PC connected to the
MAB via Ethernet were used to measure and calibrate the signals and parame-
ters on the MAB. To activate this protocol the RTIEth Setup and RTIEthXCP
Data Capture blocks were used.
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5.2.2 Approaches
The different approaches were implemented in such a way so that the signals
and trigger conditions could be altered in real time. Switches with user inputs
were added to change between different modes. The important signals were
highlighted and named which made logging of them possible. The solutions
and how they were implemented are explained in Figure 5.5 to Figure 5.9. In
Figure B.5 and B.6 a complete overview of the MAB program can be seen.

Figure 5.4: The I/O of the program on the MAB.
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PLACSLimit is used so that the engine is under full load when the adjustment
should be active. Corresponds to trigger condition 2 in Section 4.3.

hystRange decides the size of the hysteresis which the adjustment will be
active within. Corresponds to the trigger condition 1 in Section 4.3.

The Bias-block contains the parameter TRRBias which should be set to the
value of the gear shifting point.

The Gain-block contains the parameter droopPerc which is used to decide
the size of the droop limit adjustment.

Figure 5.5: The implementation of the fixed droop limit adjustment.
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TRRRange decides the size of the hysteresis which the adjustment will be
active within. The value is used in the following blocks:

• Bias2

• Bias3

• Compare To Constant2

TRRBias should be set to the value of the gear shifting point. It is used in
the blocks:

• Bias1

• Bias2

• Bias3

• Compare To Constant4

Gain7 contains the parameter TRRImpact which is used to change the steep-
ness of the linear adjustment.

Figure 5.6: The implementation of the linear droop limit adjustment.
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errorMarg is compared to the derivative of the velocity error. If the derivative
is larger the droop adjustment is deactivated. Corresponds to the trigger
condition 5 in Section 4.3.

TRRBias should be set to the value of the gear shifting point.

Constant8 contains the parameter poleOrLog which is used to change be-
tween pole and logarithmic adjustment.

Gain14 contains the parameter logGain which is used to change the size of
the droop limit adjustment for the log approach.

Gain11 contains the parameter poleGain which is used to change the size of
the droop limit adjustment for the pole approach.

Saturation1 contains the parameter poleLogLim which is used as the upper
and lower limit for the size of the adjustment.

Figure 5.7: The implementation of the pole and logarithmic droop limit adjust-
ment.
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PLACSLimit is used to tune the trigger condition 2 which can be seen in
Section 4.3.

hystRange is used to tune the trigger condition 1 which can be seen in Sec-
tion 4.3.

tddRise is used to tune the trigger condition 3 upper limit which can be seen
in Section 4.3.

tddFall is used to tune the trigger condition 3 lower limit which can be seen
in Section 4.3.

errorMarg is used to tune the trigger condition 5 which can be seen in Sec-
tion 4.3.

Gain19 contains the parameter DTRRDirGain which is used to change, ac-
tivate and select the desired behavior of the RSL solution.

Constant7 contains the parameter DTRRDirValue which is used to send a
chosen value on the RSL solution.

Constant10 contains the parameterDTRRDirConst which is used to change
between sending DTRRDirGain and DTRRDirValue.

RSL* corresponds to DTRRdir* and works in the same way.

Figure 5.8: The implementation of the RSL approach.
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errorMarg is used to tune the trigger condition 5 which can be seen in Sec-
tion 4.3.

Constant13 contains the parameter engLimActive which is used to active
and deactivate the torque limitation approach.

Gain20 contains the parameter trqGain which is used to affect the impact of
the logarithmic torque limitation.

Saturation2 contains the parameter trqSatLow which is used to declare a
lowest limit of the engine limitation.

Figure 5.9: The implementation of the engine limitation approach.
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Chapter 6

Simulink model tuning

As mentioned before the problem with alternations between the two gears occur
when driving under heavy load with a badly chosen droop limit. This phenom-
ena can be seen in Figure 6.1. It should be noticed that the following plots in-
crease with 10 seconds in i x-axis and 0.1 iG on the y-axis per vertical/horizontal
line. Another problem that can be seen here is that the step response was very

Figure 6.1: Low gain, no gain scheduling for error, no gain scheduling for critical
region and no controller/compensation active.

slow, it takes almost 20 seconds from the start of the step until a proper value
is obtained. Since the model simulations took quite a long time a lot of tuning
was performed to save time. By doubling the control power a much quicker step
response was obtained, see Figure 6.2. To handle this aggressive controller in
areas where fine/small control actions were needed gain scheduling was applied.
First a relative gain scheduling was applied that multiplies the control signal
with the ratio of the relative error (error/reference signal). Since the control

51



52 CHAPTER 6. SIMULINK MODEL TUNING

Figure 6.2: Full gain, no gain scheduling for error, no gain scheduling for critical
region and no controller/compensation active.

signal gets less aggressive closer to the reference value the control signal can be
increased even higher. This gain scheduling helps in regions where the relative
error is small and boost the control signal when the error is large. Unfortunately
it lacks effectiveness when the desired speed reference is not obtained, i.e. when
the engine speed is on the droop limit, see Figure 6.3. This is valid as long as
the reference signal is not put at the droop limit. Therefore a second gain

Figure 6.3: Full gain, gain scheduling for error, no gain scheduling for critical
region and no controller/compensation active.
scheduling was added that was active in ”critical region”, this is when possible
gear alternation may occur. This gain scheduler simply cuts about 98% of the
control signal in the critical region, see Figure 6.4. The effect of this was that the
alternation of the reference signal was kept small which resulted in a smoother
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Figure 6.4: Full gain, gain scheduling for error, gain scheduling for critical region
and no controller/compensation active

signal. As seen in Figure 6.4 the step response is now only 5 seconds, which
shortened the time consumption of the simulations a lot. When the control sig-
nal was desirable the alternation between gears needed to be fixed. The simple
solution to add a offset to the gear reference signal did not work because the
integrator part of the controller simply worked around it and no desired effect
was achieved this way. A workaround with an anti-windup was implemented
but the jumps that occurred due to the offset were not acceptable and therefore
no further investigation was made to this approach. Instead the approach of
adjusting the droop limit set by the driver was chosen. If the droop limit is set
slightly lower the iG will be slightly higher and if chosen higher a slightly lower
iG will be obtained.
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Chapter 7

Result and observations

7.1 Simulink

7.1.1 Fixed adjustment of the droop limit
The different droop limit adjustments worked quite well in general in the Simulink
model, but did not have the same success on the tractor simulator and the real
tractor.

3% negative adjustment

When within the critical region the droop limit set by the driver is adjusted
to 97% of its value. This allows iG to become slightly higher and through this
action alternation was avoided, see Figure 7.1.

3% positive adjustment

When within the critical region the droop limit set by the driver is adjusted to
103% of its value. This allows the iG to become slightly lower and through this
action alternation was avoided, see Figure 7.2.

7.1.2 Pole sliding adjustment
By continuously adjusting the droop limit by a factor dependent on a pole placed
in the gear switching point this critical region will be avoided. In Figure 7.3
negative adjustment by pole sliding to the droop limit can be seen.

7.1.3 Integral adjustment
While in the critical region a small number is multiplied by the sign of the
derivative of TRR and then integrated and multiplied by the droop limit. The
effect was similar to the fixed 3% offset but grows and decreases smoothly (in
theory) instead of jumping between the actual droop limit and the adjusted
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Figure 7.1: Full gain, gain scheduling for error, gain scheduling for critical region
and -3% to the droop limit active.

Figure 7.2: Full gain, gain scheduling for error, gain scheduling for critical region
and +3% to the droop limit active.

one. The effect can be seen in Figure 7.4. Unfortunately the integral offset
alternative was hard to implement in reality. This is since it was dependent on
derivatives from signals that were hard to get good values from even though
filters were used.
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Figure 7.3: Full gain, gain scheduling for error, gain scheduling for critical region
and pole sliding to remove gear alternation.

Figure 7.4: Full gain, gain scheduling for error, gain scheduling for critical region
and integral offset to remove gear alternation.
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7.2 Tractor simulator

7.2.1 Comparison increased/decreased droop limit

When running the droop limit adjustments on the tractor simulator observations
were made on when to increase or decrease the droop limit. When under heavier
load an increase of the droop limit, and by that lowering the gear, resulted in less
gear alternations than decreasing it did. Though under lower load the opposite
was observed, a decrease of the droop limit resulted in less gear alternations
than an increase did. It should be noted though that the terms heavier and
lower load are relative terms and that they both are quite heavy to be able
to push the engine to the droop limit. In Figure 7.51 the effect that +3%
respectively −3% is more effective for heavier respectively lower loads can be
seen. Through this comparison the conclusion that an active choice has to be

Figure 7.5: Schematic plot of the described phenomena, the top plot shows gear
alteration/non-gear alteration. The bottom plot shows the alteration made to
the droop limit.
made in real time whether to increase or decrease the droop limit depending on
the load. The degrees of freedom of the droop limit approaches were thereby
lowered. This led to problems since estimation of the current load is hard and
far from accurate, besides, when driving in the field the load is varying a lot.
The unlucky case that the loads goes from "low" to "high" within its normal

1Please not that this plot is a schematic example of the phenomena observed, no measured
values were used to create this plot.
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alternation would have a devastating effect on the control algorithm. This is
since the gear alternation would in fact be increased to the span of the hysteresis
i.e. the gear alternation amplitude would in fact increase. In this case a lock
down of the gearbox is preferred because then the lower gear may be chosen.
By this choice the efficiency loss between the gears can be compensated.

7.2.2 Range shift limitation

The RSL showed good result and completely stopped the gear alternation in the
tractor simulator. In the simulations the trigger signals that were used to acti-
vate the lock was sufficient to break the lock in various situations when the lock
down of the gearbox was undesired. One problem that occurs is that small jerks
may appear when deactivating the RSL, however this may be suppressed by
better tuned trigger conditions. The effect of the RSL in the tractor simulator
can be seen in Figure 7.6.

Figure 7.6: RSL effect in tractor simulator.

7.2.3 Torque limitation

The torque limitation proved to effectively suppress the gear alternation. How-
ever, the solution was only tested on the tractor simulator since the torque
limitation was not yet implemented in the Simulink model nor did the Xerion
5000 have a engine that supported torque limitation. The torque limitation
suffers from a problem with the trigger signals, though. If the unlikely scenario
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occurs that the load is slowly decreasing the torque limitation would not be bro-
ken. This resulted in limitations in regions where limitations were not needed.
Since the real tractor did not have the option to limit the torque of the engine
this approach was not further investigated even though it shows good potential
to handle the problem. If the approach was to be used a need for a better trig
signal is a must.

7.3 Tests on Xerion 5000

The different tests performed on the Claas Xerion 5000 were documented in a
journal that is attached to this report in Appendix C.

7.3.1 Positive or negative adjustment of the droop limit

It was observed that an active choice has to be made regarding a positive/negative
adjustment of the droop limit. This observation was also made in the tractor
simulator and thereby strengthened the theory. The effect is shown in Fig-
ure 7.5. After this some thoughts of load estimation occurred but was quickly
discarded, since load estimation is quite tricky. Instead approaches of trying
to stay on the side of the switching point that the TRR currently is located
on. This idea led to version 2 of the pole adjustment of the droop limit. By
not having an absolute value function different alternations will be performed
depending on from which direction TRR approaches the gear shifting point.

7.3.2 Pole adjustment

The pole adjustment successfully suppress most of the gear alternation, some
alternation pass through most likely due to the engine oscillations explained in
Section 7.3.4. The adjustment made to the droop limit was of the same size as
calculated in Example 1. This can be seen in Figure 7.7

7.3.3 Range shift limitation

Since the RSL singal that existed on the VDC suffered from an anti-windup
problem a firmware update that locked the reference signal to the gearbox,
DTRR, was implemented. This limitation could be used in a similar way as the
RSL signal and therefore replaced it in the implementations. The range shift
limitation had a major effect on the gear alternation and proved to sufficiently
suppress the problem. The criteria mentioned in Section 4.3 seemed to have
good potential. With some tuning this method could possibly solve the gear
alternation problem, at least according to the results acquired on the test track.

To lock the gearbox in the lower gear seamed to achieve a better result than
the upper gear. A lock in the upper gear may work in some cases, however
since the efficiency is lower the ability to handle a large load is better in the
lower gear and therefore a lock down in the lower gear is preferred. The reason
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Figure 7.7: How pole adjustment affects the gear alternation on the real tractor.
The droop limit is pushed slightly higher which keeps the gear ratio TRR just
below the shifting point 0.37..
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why it did not always work to lock in the upper gear is due to a safety function
implemented in the VDC that allowed gearing down even when a lock down
was made. In Figure 7.8 the result from a test drive on the tractor can be seen.
In that figure the tractor is driven for a little more than 3 minutes whereupon
the RSL is activated and with that the gear alternation suppressed. At first

Figure 7.8: How RSL affects the gear alternation on the real tractor. RSL was
activated at 10 min and some tweaking of the trigger conditions were performed
whereupon the alternation stopped.

the RSL has no effect on the gear alternation but after a minute of criteria
tweaking it successfully suppresses the alternation. The lack of effectiveness
in the beginning occurred since the PLACS dropped before each gear change
while the criterion PLACS should be above 98% percent, see Figure 7.10 for
the effects of the drop. How the transmission ratio, TRR, is locked under a
chosen limit can be seen in Figure 7.9. With a closer look it can be seen that
the TRR sometimes peaks above the limit, this is due to influences from the
clutches. This is the reason why the limit is set to 0.365 instead of the switching
point 0.37.

7.3.4 Engine load drop
During the tests on the real tractor it was observed that the engine load dropped
before each gear alternation. The reader should notice that this effect occurred
both when the suggested solutions were and were not active. This created a
bit of a problem since one of the criteria that triggers the different solution was
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that the engine load should be close to 100%. The best explanations for this
problem was that the velocity controller was poorly tuned for driving with the
brake trailer. In Figure 7.10 the following signals can be seen:

• The speed reference to the engine, RSSL. (Red)

• The droop limit. (Blue)

• The engine speed also know as the transmission input shaft speed, TISS.
(Green)

• The state of the gearbox (shifting or no shifting), TRS. (Yellow)

• The gear ratio of the gearbox, TTRR. (Purple)

• The engine load, PLACS. (Orange)

From this picture the conclusion can be drawn that the velocity controller is
not perfectly tuned for the tractor with the brake trailer. This resulted in
the engine speed reference alternating which led to the alternation of the other
signals. When the PLACS criterion was removed as a trigger signal the different
solutions were active at the right times.

RSL

The RSL solution effectively suppresses the gear alternation even though the
whole system (engine speed reference, engine speed and PLACS) oscillates. It
all so had the appreciated effect that all these oscillations were decreased in
amplitude. The Figure 7.11 is equal to Figure 7.10 except that the RSL was
active.

Pole adjustment

The pole adjustment also had a good effect on the engine oscillations and
suppressed the gear alternation in a satisfying way. This can be seen in
Figure 7.12, the colors are explained in the list below:

• The adjusted droop limit. (Red)

• The droop limit. (Blue)

• The engine speed also know as the transmission input shaft speed, TISS.
(Green)

• The state of the gearbox (shifting or no shifting), TRS. (Yellow)

• The gear ratio of the gearbox, TTRR. (Purple)

• The engine load, PLACS. (Orange)
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Figure 7.9: The TRR stays below the DTRR limitation when RSL is active.

Figure 7.10: The effect of the badly tuned velocity controller.
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Figure 7.11: The effect of the RSL on the badly tuned velocity controller. As
seen the RSL have both a positive effect on the gear alternation as well as the
engine oscillation.
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Figure 7.12: The effect of the pole adjustment on the badly tuned velocity
controller. As seen the pole adjustment had both a positive effect on the gear
alternation as well as the engine oscillation. However the effect was not quite
as good as the RSL effect.



Chapter 8

Conclusions

The three different approaches (droop limit adjustment, RSL and torque limi-
tation) are evaluated in the Table 8.1.

8.1 Droop limit adjustment
The droop limit adjustment suffers from the choice to increase or decrease the
droop limit. This choice should be made with consideration to the load, which
makes it tricky since the load is rather hard to estimate. However, if a good
estimation was to be found the method shows good potential to remove more
alternations than in its current state. The large advantage of this approach is
the simplicity due to the few degrees of freedom.

8.2 Range shift limitation
Range shift limitation successfully removes gear alternation but the high amount
of degree of freedom requires a lot of tuning. The idea of locking the gearbox may
not be desirable by all drivers since it limits the driving freedom and may cause
small jerks when deactivating the lock-down. This approach is the one that
shows the highest potential at its current state and is therefore recommended
by the authors of this thesis.

8.3 Torque limitation
This approach has great potential, however, it suffers from two major draw-
backs. One is that not all the engines have the possibility to limit the torque.
The other is that so far no sufficient trigger conditions have been found. The
great potential comes from the ability to successfully suppress gear alternation
without affecting the driver settings. Though, as in the range shift limitation
some drivers might not like the idea of limiting the engine.
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Table 8.1: Comparison of methods.



Chapter 9

Future work

In the list below ideas for future work can be seen.

• Find trigger condition for the torque limitation approach since it showed
good potential.

• Investigate how large percentage of the ECCOM customers that have an
engine with torque limitation to evaluate its potential value.

• In the future when the VDC has got a larger calculation capacity the pos-
sibility to use an optimal controller should be investigated. Good models
of the process have already been created so in the future these models
could be used in the optimal controllers such as MPC1 or LQR2. The
models used in the optimal controller should take the gear efficiency table
into account as well as the torque output of the engine.

• Conduct a field test drive to validate the conclusions from this thesis.

• Find alternative trigger conditions to allow implementation of the solu-
tions in the TCU rather than the VDC.

• Develop a load estimator to enable more accurate decisions regarding the
choice of the second or third gear. The load estimation could be included
in all the approaches. It could also be included in the future optimal
controller to have an optimization that takes the load into account.

1Model predictive control.
2Linear quadratic control.
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Appendix A

A short guide to
MicroAutoBox II

A.1 Introduction
This guide explains how MicroAutoBox II and the programs related to it were
set up for the project described in report Reduction of undesired range shifting
in an agricultural CVT. The MAB that was used contained a DS1401 base board
and a DS1507 I/O board. Besides MicroAutoBox II, the following hardware and
software were used:

• Matlab R2009bSP1 and Simulink

• ControlDesk Basic Version 3.7.1, Real-Time Workshop 6.7 and TargetLink
3.1 from dSPACE

• CANcaseXL log, CANalyzer 7.6.84 and CANape 10.0 from Vector

• USB-Ethernet adapter1

It is assumed that the above software is installed properly on the computer
that is to be connected to MicroAutoBox II. It should be noted though that the
installation of Real-Time Workshop and TargetLink caused a lot of problems
for the authors of this guide. If the reader has problems with this as well,
Section A.7 comment 1 might be helpful. Other versions of the software might
work as well, but some of the steps in this guide may differ. It should also be
noted that the used computer was running on Windows 7.

The guide starts with the hardware (CANcaseXL log and MicroAutoBox II)
connections and then explains every step of creating a Simulink model to test-
ing it on the MicroAutoBox II, including software configurations. It focuses on
setting up XCP2 on CAN (with the CANcaseXL log device) and then explains

1The benefit of using an adapter is that the computer may stay connected to the company’s
network while connected the the MAB.

2Universal measurement and calibration protocol
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how to adjust the settings for XCP on Ethernet (TCP/IP and UDP/IP). Fur-
thermore, during the whole guide, it should be kept in mind that all components
using the CAN must be set to the same baud rate to be able to communicate
correctly with each other. The default baud rate is usually 500 kBd by default,
but this guide will use 250 kBd.

A.2 Connecting the hardware
For the connection between the MicroAutoBox II and the computer to work the
TCP/IP protocol for the USB-adapter3 and the Peer-to-Peer connection has to
be set. For this, administrator rights are required. It might be a good idea to
write down the previous TCP/IP configurations to be able to restore them later
on. These steps can also be found in [9], page 116 – 119.

1. Go to Control Panel ⇒ Network and Internet ⇒ Network and
Sharing Center .

2. Open the Local Area Connection Status-window by clicking onView Sta-
tus of Local Area Connection .

3. Click on Properties.

4. Select Internet Protocol Version 4 (TCP/IPv4) and click on Prop-
erties.

5. Select Use the Following IP address and enter 192.168.140.3 in the
IP address field and 255.255.255.0 in the Subnet Mask field according to
figure A.1.

6. Close all opened windows by clicking on OK when possible and Close
when not.

7. Restart the computer if asked for.

8. If the computer is already a part of an existing network, switch the com-
puter off and disconnect the network.

9. Connect a cable with a USB/Ethernet adapter to Host PC on MicroAu-
toBox II and a USB port on the computer.

10. Connect ≈12-14 V to Power on MicroAutoBox II and turn the computer
back on. More information on connecting the power can be found on page
96 in [9].

11. Open a Command Prompt (open the Start menu and search for cmd).

12. In the Command Prompt enter ping 192.168.140.1 (which is the default
IP address MicroAutoBox II)

3External network card connected by the USB interface.
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Figure A.1: Settings for the internet protocol. Here .2 is used at the end of
the IP address. It is possible to use any ending between .2 and .254 but if
DCI-GSI25 is also connected note that its default IP adress is 192.168.140.2.

13. If you receive a reply from 192.168.140.1 (i.e. ”Reply from 192.168.140.1:
bytes=32 time<10ms TTL=64”) then the connection is ready for use, see
Figure A.2.

Figure A.2: Desired answer when pinging the MicroAutoBox II.

To connect the CANcaseXL log with the MicroAutoBox II and the computer,
connect a cable between USB on CANcaseXL log and a USB port on the

5Generic serial interfaces.
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computer. Then connect the DS1507 I/O Connector on MicroAutoBox II
to a channel on CANcaseXL log. A 120 Ω resistor needs to be placed between
the cable and the CANcaseXL log channel, this does not apply for the real
tractor or the tractor simulator. The connection is now complete.

A.3 Creating a Simulink model

When starting Matlab the Select dSPACE RTI Platform Support-window will
appear if Real-Time Workshop is installed. Select the option corresponding
to the MicroAutoBox II, in this case RTI1401 . Then, when the start-up
configurations are done, enter rti in the command window. This opens a window
for access to the Real-Time Interface blocks, see Figure A.3. By clicking on
Blocksets ⇒ RTI CAN Blockset the blocks for CAN-communication are
found, see Figure A.4. From here, the necessary blocks for CAN-communication
can be found. These are as follows:

Figure A.3: The library for Real-Time Workshop.

• RTICAN Transmit (TX) is used for sending a message from the Simulink
model to the CAN. The signals to be sent in the CAN message are the
inputs to the block. The outputs of the block do not need to be connected.
Inside the block the message name, identifier and length can be specified
as well as the message composition, i.e. which bits of the message corre-
sponding to which input of the block. Adding more signals creates more
inputs to the block.
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Figure A.4: Blocks for utilizing RTI on CAN. This window can also be accessed
by entering rtican in the Matlab command window.

• RTICAN Receive (RX) is used for receiving a message from the CAN
to the Simulink model. Inside the block the message name, identifier and
length can be specified as well as the message composition, i.e. which
bits of the message corresponding to which output of the block. The only
outputs that need to be connected are the signals of the CAN message
that are to be used, i.e. the outputs corresponding to the desired signal
names defined in the block. Adding more signals creates more outputs to
the block.

• There must be at least oneRTI CONTROLLER SETUP in the Simulink
model to be able to use any of the RTICAN blocks. This block specifies
the CAN configurations and each Transmit and Receive block must be
associated with one of these blocks. There are no input or output signals
for this block.

• The RTICANXCP data capture block is found by going to Library
Extensions ⇒ XCP Support or by entering rticanxcp in the Matlab
command window. This block is used for data acquisition with XCP on
CAN, i.e. to access signals and parameters in the Simulink model on the
hardware. There are no input or output signals for this block.
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With this information the desired Simulink model for CAN communication
can be constructed in the following way:

1. Add a RTI CONTROLLER SETUP block for each CAN controller to be
used (more than one Receive and/or Transmit block can be associated
with each CAN controller), this guide uses one of this block.

2. Double-click on the block to access its options.

3. Edit the baud rate in the Unit-tab

4. Activate Enable XCP support in the XCP -tab.

5. Add a Transmit/Receive block for each CAN message to be transmit-
ted/received by the modell.

6. Double-click on the block and edit (or take note of) the RX message
parameters in the Message-tab

7. Add the desired signals for the CAN message in the Message Composition-
tab. Figure A.5 shows an example of this tab.

8. Add a RTICANXCP data capture block to the model.

To be able to access signals and parameters on the MicroAutoBox II they
need to be identified in the Simulink model before it is downloaded to the
MicroAutoBox II. How to do this is explained in the first part of Section A.5.2.

A.4 Downloading a Simulink model to MicroAu-
toBox II

Before downloading the model to the MicroAutoBox II the connection between
the MicroAutoBox II and the computer needs to be established. First make
sure MicroAutoBox II is powered and connected as described in Section A.2.
Then complete the following steps:

1. Open the Start menu⇒All Programs⇒ dSPACE Tools⇒ dSPACE
ControlDesk 3.7.1 and click on dSPACE ControlDesk 3.7.1 .

2. Go to Platform ⇒ Change Connection. . . .

3. Select Network connection and enter the default IP address for Mi-
croAutoBox II, 192.168.140.1, according to Figure A.6.

4. Click on OK .

5. The Log Viewer should now say that the connection to the network client
is completed.
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Figure A.5: Example of a CAN message received by the Simulink model con-
taining two signals.

There are also a few configurations to be made in the Simulink model. Go
to Tools ⇒ Real-Time Workshop ⇒ Options. . . in the window for the
Simulink model and make the following changes:

• Go to Optimization and activate Inline parameters.

• Go to Data Validity and change Signal resolution to Explicit and
implicit.

• Go to Real-Time Workshop and add -aASAP2ParamAutoGenerate=1
-aASAP2SignalAutoGenerate=1 to theTLC options line so that it says -
aGenerateASAP2=1 -aASAP2ParamAutoGenerate=1 -aASAP2SignalAutoGenerate=1
as in Figure A.7.

• If the model is to be downloaded to the Flash memory, so that it stays
on the MicroAutoBox II even if the power is turned off, go to RTI load
options and activate Load to Flash memory .

Now, click on OK and go to Tools ⇒ Real-Time Workshop ⇒ Build
Model to download the model to the MicroAutoBox II.
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Figure A.6: Settings for establishing a connection between the MicroAutoBox II
and the computer.

Figure A.7: Settings for the Real-Time Workshop build process.

A.5 Using CANalyzer and CANape

Before using CANalyzer and CANape they must be added to the Vector hard-
ware. This is done by completing the following steps:

1. Go to the Control Panel ⇒ Hardware and sound ⇒ Vector Hard-
ware .

2. In the left menu of the Vector Hardware Config-window open Hardware
⇒ CANcaseXL log 1 .

3. Right-click on one of the CANpiggy 251mag (Highspeed).

4. Choose the program and CAN to be used, i.e. CANalyzer ⇒ CAN 1 and
CANape ⇒ CAN 1.
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A.5.1 CANalyzer

Start with editing the baud rate by going to the Configuration window at the
bottom of the CANalyzer window, then double-click on the chip at the left.
From there, select the CAN used and change the baud rate . When the program
is ready, click on the lightning symbol named Start to activate CANalyzer. It
can then be stopped by clicking on the red symbol named Stop.

To view messages on the CAN, open the Trace window. Here, all messages
on the CAN will be displayed. The list can be expanded or compressed by
clicking on the Toggle display mode button (symbolized by a document with
an orange arrow pointing downwards). The continuously updating list can be
paused by clicking on the Pause button.

The following steps explains how to create a messages that are to be sent on
the CAN:

1. Right-click on the blue square going towards the SEND-symbol in the
Configuration window.

2. Select Insert Interactive Generator Block .

3. Double-click on the newly created IG.

4. Click on New to create a CAN message.

5. Enter an identifier and the desired value on each byte (and change the
Channel and message length (DLC) if required). Note that the identifier
for a message in CANalyzer has to be the same as the message identifier
in the RTICAN Receive (RX) block for the block to be able to receive the
message. The bytes in the message also have to correspond to the bytes
of the desired signal in the RTICAN Receive (RX) block.

6. To send a message, either click on now to send it once or activate a
suitable cycle time to send it continuously.

Read Section A.7 comment 3 before sending or viewing messages exceeding
one byte.

A.5.2 CANape

To gain access to signals or parameters in CANape, they must be initialized in
the Simulink model before downloading it to the MicroAutoBox II.

• For a signal, thist is done by right-clicking on the line of the signal ,
selecting Signal Properties. . . , entering a name in the Signal name
field and clicking on OK .

• For a parameter, enter the block with the parameter and change the
value to a name and click on OK . Then go to the Matlab command
window and assign a value with the same name.
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By doing this, the name of the parameter and the assigned value should
be displayed in the Matlab workspace. After building the Simulink model, the
named signals should also be displayed in the Matlab workspace.

Enter CANape and do the following initializations:

1. Go to Device ⇒ New from Database. . . .

2. Find the <simulink model name>.a2l file andOpen it. This file is created
when building the simulink model and should be located in the folder path
that were active in Matlab when the model was built.

3. Select OK on the windows popping up, thereby uploading the data from
MicroAutoBox II to CANape.

4. Go to Measurement ⇒ Measurement Configuration. . .⇒ Edit ⇒
Insert signal .

5. From the list, select the desired signals and parameters by marking them
and clicking on Apply (or double-clicking on them).

6. Close the windows and accept the changes if asked.

Now the setup is done and it’s possible to add windows to view signals and
change parameters in the following way:

1. Go to Display ⇒ Display windows ⇒ Graphic window to add a
graphic window. The graphic window shows a graph of the desired signals.

2. To add one or more signals to the window, right-click inside of it and go
to Insert ⇒ Insert measurement signal. . . .

3. Add the signals to be viewed from the MicroAutoBox II by selecting them
and clicking on Apply .

4. Right-click in the window again and go to Configurations. . . . Here it’s
possible to for example change axis scaling for each individual signal in
the window.

5. If desired, add other kinds display windows to get a different view of the
signals.

6. To change a parameter in the MicroAutoBox II go to Display ⇒ Cali-
bration windows ⇒ Calibration window .

7. Select a data source if asked.

8. Add the desired parameters to be changed by selecting them and clicking
on Apply .

9. In the new calibration window, when the measurement is running, click
on a value and enter a new value to change it in the MicroAutoBox II.
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Click on the lightning symbol named Start the measurement or any of the
adjacent symbols to start, pause or stop the measurements. For a few additional
basic features in CANape read [10].

A.6 XCP on Ethernet
XCP on Ethernet uses the same connection as used when downloading a model
from Simulink to the MicroAutoBox II. This means that the same connection
as explained in Section A.2 needs to be established. The only differencefrom the
previous connections is that the CANcaseXL log does not need to be connected
to the MicroAutoBox II. In the case of this guide though, the CANcaseXL
log still needed to be connected to the computer since it held the license for
CANape.

Before setting up XCP on Ethernet XCP on CAN should be set up according
to the previous descriptions of this guide. Then, the following changes can be
made:

1. Enter rti in the Matlab command window and go to Blocksets ⇒ RTI
ETH XCP Blockset to gain access to the XCP on Ethernet blocks seen
in Figure A.8.

Figure A.8: Blocks for utilizing RTI on Ethernet. This window can also be
accessed by entering rtiethxcp in the Matlab command window.

2. Add the blocks RTIEthXCP Setup and RTIEthXCP Data Capture to the
Simulink model.

3. In the RTIEthXCP Setup block, change Use XCP via to Ethernet Host
Interface.

4. In the same block, change and/or take note of the port number displayed
in the Ethernet port field.

5. In the CAN CONTROLLER SETUP block, go to the XCP-tab and dis-
able Enable XCP support .
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6. Delete the RTICANXCP data capture block in the Simulink model.

7. Go to Tools ⇒ Real-Time workshop ⇒ Options. . .⇒ Real-Time
Workshop in the Simulink model.

8. In theTLC options field, change -aGenerateASAP2=0 to -aGenerateASAP2=1.

9. Download the model to the MicroAUtoBox II. If an error during the build-
ing occurs, read Section A.7 comment 2.

10. Open CANape and go to Device ⇒ New from database. . . .

11. Open the .a2l file created when building the Simulink model by selecting
it in the Select database for the device-window.

12. Select Offline .

13. Go to Device ⇒ Device Configuration .

14. Click on the + next to Protocol under the newly created device and select
Transport Layer .

15. Change Host to 192.168.140.1 (the default IP address for MicroAutoBox
II) and Port to the port number chosen in step 4.

16. Right-click on the device name and select Online . It might have to be
taken offline and then back online again to get the Cache Synchronization-
window.

17. Select Upload and click on OK .

18. If there are other devices in the device list, deactivate the ones not used
by right-clicking on them and deselect Device active .

XCP on Ethernet is now ready to be used in the same way as XCP on CAN
was used.

A.7 Comments

1. As mentioned before the installation of Real-Time Workshop and Tar-
getLink caused a lot of trouble. Therefore the following comments explain,
in short, how these problems were solved.

• Even if running on a 64-bit operating system, a 32-bit Matlab were
installed. This was needed since all the programs weren’t 64-bit
compatible.

• Windows Compatibility mode where deselected according to [11].
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• Real-Time Workshop (also known as RCP and HIL 7.1) and Tar-
getLink were installed with two different CDs. To install them in the
same directory, which is required, TargetLink 3.1 was installed first.
Then, to install Real-Time Workshop, the Install_RCP_HIL.exe
file found in the RCP&HIL folder on the other CD was executed. It
does not work to run dSPACE Master Setup instead.

2. The -aGenerateASAP2=1 command in Real-TimeWorkshop option changes
when Enable XCP support is changed in the CAN CONTROLLER SETUP
block. When Enable XCP support is enabled -aGenerateASAP2=1 and
when it is disabled -aGenerateASAP2=0. There is a bug in Real-Time
Workshop 6.7 which was used in this report. The bug occurs when building
a model where Enable XCP support is disabled and -aGenerateASAP2=1,
which is required when using XCP on Ethernet. If an error implying this
occurs when building the model (an error saying there is something wrong
with a file not related to the model) close Matlab and run the following
hotfix file from dSPACE:
http://www.dspace.de/hotfixes/DS_RTI_67_HF218732.exe.

3. When, for example, sending a message with a two byte (or larger) signal
from CANalyzer to the model on MicroAutoBox II, or when reading a
signal on the CAN in CANalyzer, the bytes will appear as if they have
switched places6. The signal 07E8 will for example appear as E807. This
should be remembered when using CANalyzer since CANalyzer is con-
nected directly to the CAN. When sending from one application to another
through the CAN this will not be a problem though.

6This due to the two different orders to represent bytes, big-endian and little-endian.
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Appendix B

Simulink models with
appertaining values and
enlarged figures

B.1 Simulink
This section contains most of the Simulink models used. The values used during
Simulations are added in the captions of the figures.
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Figure B.1: Enlargement of Figure 5.1. Gain 6: 95%-99.9% control signal cut
away if critical region active. Extra gain for I part: When I adaption is active a
large I-gain may be used, value= 0.25 equals 4 times stronger. Avoid 0 control
signal: Is used to avoid a lock when the control signal is completely canceled
when change is needed.
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Figure B.2: Enlargement of Figure 5.2. I-gain: Value=150. ON_OFF: Is a
precaution to prevent the controller to start trying to control before the system is
ready. The factor I-adaption increases or decreases the control signal depending
on the situation.
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Figure B.3: Enlargement of Figure 5.3. Bias: The bias 100 is added so that
the droop limit controller stays a little bit over the velocity controller during
normal operation. The gain1 is 1/1000 to get the derivative signal more easily
handled. The mean filter output is the mean of the last 10 values.
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Figure B.4: Enlargement of Figure 3.3. For the values of Gain-Gain5 as well as
the compare to constant, see Table 3.1.
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Figure B.5: Enlargement of the overview of the MAB program part 1.
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Figure B.6: Enlargement of the overview of the MAB program part 2.
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B.2 Large figures
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Figure B.7: Enlargement of Figure 3.6.
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Figure B.8: Enlargement of Figure 2.12.
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Figure B.9: The different alternation made to the droop limit by the different
approaches.
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Figure B.10: Overview of the controlled process, logic represent different ap-
proaches to solve the gear alternation.
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Figure B.11: Gear alternations while driving on the field.
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Appendix C

Logbook from test runs on
Xerion 5000

12/12-12
Software test on the real machine, first try. Connection of MicroAutoBox II and
accessories were successful. The data was easy to obtain while connected but
unfortunately the USB-network adapter kept disconnecting from the computer
which interfered with the logging of data. This has also been a problem before
at the office and no good reason for this behavior has been found. Most of the
time when this occurs the LEDs on the adaptor stops flashing and a message
appears saying the computer can’t recognize the USB device, but sometimes
that is not the case. Then the only way to notice the error is to pay attention to
the loggings and see when data is lost. Alteration of the program is very hard
to implement in the field due to the movement of the machinery and the cold
environment. During the test the gear switching point was found, it occurred
at TRR = 0.37. Drives with the droop limit adjustment was tried, it did reduce
the gear alternation but didn’t remove them completely. Further adjustments of
the trigger signals are needed. The parameters are harder to adjust on the real
tractor though due to the fact that gear alternation is much easier obtained and
kept occurring constantly in the simulations. Observation of the RTS signal
showed intentions of gear shifting but not all got through to full gear shifts.
To lower the droop limit seemed to be more effective than the increased droop
limit. This effect is a bit odd and contradicts the results from the simulations
that indicated that a higher droop limit would have a more desired effect. This
result needs to be further evaluated and confirmed during the next run. Plans
for next test run:

• Improve user interface to highlight important signals, hopefully easier tun-
ing is obtained by this.

• Try a new USB-network adapter that’s hopefully not disconnecting all the
time so data from the runs may be saved and analyzed at the office.
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• Get logged data from a pair of good gear alternation runs for tuning and
analyzing back at the office.

• Evaluate which of the droop limit adjustments (higher or lower) that have
the more desirable effect.

• Try the effect of the RSL signal.

• Try to tune the RSL controller to solve the gear alternation problem.

• Check the trigger signal that the RSL controller uses, if the signal behaves
good other controllers can benefit to use this signal as well.

• Check several conditions for the gear alternation to have the opportunity
for alternative trig signals.

18/12-12

The setup worked fine, though it should be kept in mind that the right VDC
needs to be connected to the system if all signals are to be used correctly.
Apparently the RSL, range shift limitation, is not implemented on the tractor
or the value for RSL that we send does not reach its destination. This has
created a bit of a fuss at the department because the gearbox is sold with
this feature even though it might not even be implemented in the real vehicle.
Because of this error the RSL controller could not be tested and evaluated. The
linear droop limit controller has a much more desirable rpm signal which follows
the droop limit better than the fixed droop limit controller. The alternation of
the droop limit is smaller with the linear controller and therefore the effect of
this change is harder to detect for the driver, which is a good review. It was
also noticed that decreasing the droop limit where better in some situations
and increasing it where better in others. No explanation of when to increase or
decrease the droop limit has yet been found. For future notice the load should be
in position 5 on the tractor to obtain a good load that keeps PLACS at 1 while
it is possible to switch between the gears. The new USB-adapter was a great
improvement and didn’t crash once during the test drive. Gear alternation was
obtained by alternation of the cruise control, which is highly unlikely to obtain
the same result as heavy load and droop limit alteration. To do before the next
test run:

• Talk to the department and get the RSL working.

• Check the load estimations to see if it can be used to determine the choice
of increased or decreased droop limit adjustment.

• Further research regarding the alternative way to create gear alternation.

• (Added after simulations in the lab) Test if the result that determination
between increasing/decreasing droop limit depends on the current load.



101

1/2-13
The signal RSL is set to one and two, this makes no difference and the vehi-
cle gears as usual. The pole droop adjustment gives us hope and successfully
suppress the gear alternation. Though it should be kept in mind that on the
test track the alternation only occurs about once every 10 second cycle but in
the field the alternation occurs up to once per second. But the results are still
positive and further testing is needed to confirm the results. If the alternation
occurs more frequently the RSL no prediction signal should be applied to avoid
gear switching by mistake. Other observations were that a fixed alteration of
the droop limit fixes the problem for the current load but instead another load
is badly combined with the new droop limit. The load options on the test track
is a bit limited and droop limits can be chosen so that no alternation occurs,
but this is most likely due to the fact that the right load is not acquired. On the
track the TOSS/TISS was more or less the same as TRR unlike on the tractor
simulator. To do before the next run:

• Hope that someone fixes the RSL implementation until next test drive.

• Implement and test the logarithm adjustment of the droop limit. This
is because the pole adjustment gives good hope and the log approach is
quite similar, but have the advantage of not increasing as steeply.

• Look over the possible opportunities to test drive at some filed to see the
controllers effect in the real soil, with full gear alternation and dynamic
load.

20/2-13
The new implementation of the RSL signal in the VDC works well. The trigger
conditions worked well and the gear alternation was suppressed in a good way.
The trigger conditions were not tuned during this run so the solution has got
a large room for improvement. It was noticed that the engine speed alternates
in the critical region, this effect occurred with and without any influence from
the MAB. A good set of data was collected for the RSL run however during
the test of the pole adjustment the breaking wagon started to behave in an
undesirable way and no further testing of the pole adjustment was performed.
An interesting observation was made that the PLACS dropped before the range
shifting each time this effect can be seen in figure 7.10. This effect was believed
to occur when the reference signal (RSSL) was change. This effect was also
believed to be the explanation to why the motor speed alternates.

• Try to get another test drive to test the pole adjustment.

• Try booking a test drive in the field.
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Appendix D

CAN message table

D.1 Created CAN messages

byte
0 1 2 3 4 5 6 7 Identifier

mab2vdc adjDroopLim DTRRLim eLim ∗ not used 18E705F9
vdc2mab droopLim Ve not used 18E7F905

Table D.1: Created CAN messages

bit
0 1 2 3 4 5 6 7

∗ Byte 5 onoff RSL DTRRLimDir not used

Table D.2: Byte 5 of mab2vdc

D.2 Used CAN messages
byte

0 1 2 3 4 5 6 7 Identifier
EEC2 not used PLACS not used CF00300

PTCDN1 not used TISS not used CFF6703
PTCDN2 not used TRR not used CFF6803

Table D.3: Used CAN messages

D.3 Description of the signals in the CAN mes-
sages

adjDroopLim is the adjusted droop limit that is sent to the VDC from the
MAB when one of the droop limit approaches are activated.
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droopLim is the droop limit set by the driver.

DTRRLim is the value that the gearbox should be locked above or below
depending on the value of TRRLimDir.

DTRRLimDir determines if the gearbox should be locked above or below the
gear shifting point. 0 equals no limitations, 1 equals a lock below and 2
equals a lock above value set by DTRRlim.

eLim is the engine limitation. This value corresponds to how many percent of
the engine torque that should be available.

onoff is a onoff switch that tells the VDC if a droop limit adjustment should
be active or not.

PLACS is a signal from the engine that states how much of the engine torque
that is currently used.

RSL is the range shift limitation signal. It states whether the gearbox should
allow shifting or disapprove shifting. 0 means that no limitation are active,
1 means no up shit, 2 means no down shift and 3 means look ahead which
means no prediction.

TISS is the input speed to the gearbox.

TRR is the gearbox current gear ratio.

Ve is the velocity error of the vehicle.

D.4 Table of the signals used in the CAN mes-
sages

Message Identifier Startbit Length Scale Offset
adjDroopLim mab2vdc 18E705F9 0 16 22 0
droopLim vdc2mab 18E7F905 0 16 22 0
DTRRLim mab2vdc 18E705F9 16 16 10000 0
DTRRLimDir mab2vdc 18E705F9 44 2 1 0
eLim mab2vdc 18E705F9 32 8 1 125
onoff mab2vdc 18E705F9 40 1 1 0
PLACS EEC2 CF00300 16 8 100 0
RSL mab2vdc 18E705F9 41 3 1 0
TISS PTCDN1 CFF6703 32 16 23 0
TRR PTCDN2 CFF6803 16 16 10000 0
Ve vdc2mab 18E7F905 16 16 26 0

Table D.4: Used signals on CAN messages
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